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Overview

Dragon Medical® 360 | Desktop Recorder allows you to quickly create dictations and send them for 
back-end speech recognition or transcription. 

Log In

1. Double-click the Desktop Recorder icon. (The application automatically checks 
for and installs any updates for your system.)

2. When the Login dialog box opens, enter your user name (if it is not already there) and 
password, and click Log on. A login status box appears briefly, indicating your login 
progress.

3. If you are set up to dictate at more than one site, the Site Selection list opens, allowing you 
to select a site. Select a site and click OK.



Chapter 1: Overview, Logging In, and Logging Out
Tips
• Double-click the User name field to see a list of users from which you can select your user 

name.

Note: If the computer you use has many users (for example, a public computer), type 
the first few characters of your login name. A drop-down list appears and is filtered by 
those character. Press the down arrow key to highlight your login and press Enter to 
select it.

• If you have more than one system profile, use the drop-down arrow to select the appropriate 
profile.

• To manage your system profiles, click the blue Manage system profiles link. (For 
information on managing system profiles, see System Profiles, beginning on page 7.)

• To configure your Dragon Medical 360 | Desktop Recorder application settings, click the 
gear icon in the lower-right corner of the login dialog box. (For information on managing 
application settings, see Application Settings, beginning on page 11.)

• For Windows 7 and higher: If you do not see the gear icon in the illustration above, right-
click the Desktop Recorder icon and select Run as Administrator. 

Toolbar Overview
The Dragon Medical 360 | Desktop Recorder appears as a toolbar on your computer. You 
control all of the application’s functions from the toolbar. 

The following illustration gives you an idea of what you will typically see after logging in. (Due 
to its width, the toolbar is split into two pieces in this illustration.)
3
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Quick Start
Use the following steps to quickly record and send a dictation. 

1. Log in to Dragon Medical 360 | Desktop Recorder.

2. Select a work type (if you dictate on more than one worktype).

3. If required, enter the Visit ID (or MRN or accession number).

4. Press the Dictate button on your microphone and dictate your report.

5. Press the Send to Transcription button on your microphone.

Log Out
When you log out of the application, a dialog box opens asking you to confirm the log out. The 
dialog box that opens depends upon the status of the jobs on your system:

• If you are currently dictating a job (the job is in either the Record or Pause mode) and 
attempt to log out, the Current Job Disposition dialog box opens. (See Logging Out While 
Current Job is in Record or Pause, beginning on page 5.)

• If there are jobs on your computer waiting to be uploaded to transcription, the Jobs Waiting 
Upload dialog box opens. (See Logging Out With Jobs Awaiting Upload, beginning on 
page 5.)

• If you are not currently working on a job, and all jobs have been uploaded, the Confirm 
Logout dialog box opens. (See Logging Out, No Jobs Awaiting Upload, Current Job 
Complete, beginning on page 6.)

How Do I Log Out?

To log out of the system, perform one of the following steps: 

• Click the Current User/Log Out icon on the toolbar. 

• Click the Dragon logo  and select Logout.

• Press Shift+F4.
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Logging Out While Current Job is in Record or Pause

If your current job has not been sent to transcription, the Current Job Disposition dialog box 
(shown below) opens.

• Yes (or press the Y key): Cancels the current job and opens the Confirm Logout dialog box. 

• No (or press the N key): Returns you to the application, allowing you to finish working with 
the current job.

Logging Out With Jobs Awaiting Upload

When you log out of the application and there are jobs waiting to be uploaded, the Jobs Waiting 
Upload dialog box (shown below) opens. This dialog box warns you that there are outstanding 
jobs that need to be uploaded and asks you to confirm that you want to log out now, and not 
upload the jobs until the next time you log in to the system.

• Yes (or press the Y key): Jobs are not uploaded until the next time you log in. Opens the 
Confirm Logout dialog box.

• No (or press the N key): Returns you to the application.
5
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Logging Out, No Jobs Awaiting Upload, Current Job Complete 

If you log out with all jobs uploaded and no current job open, the Confirm Logout dialog box 
(shown below on left) opens. 

• Yes (or press the Y key): Logs you out of the application. 

• No (or press the N key): Returns you to the application.

When logging out, the application will temporarily show a Logging out dialog box (shown 
below on right). It provides feedback about what the application is doing. On log out, the 
application attempts to upload the diagnostic log files to the Nuance Management Server.
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Overview

Before you can log in to Dragon Medical 360 | Desktop Recorder, you must create a system profile. 
If you dictate for more than one organization, you can create additional system profiles for each one, 
allowing you to select the appropriate organization when you log in to the application. If you create 
additional system profiles, use the System profile drop-down list to select a system profile.

Add a System Profile
To add a system profile: 

1. From the login dialog box, click the Manage system profiles link to open the dialog box.
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2. Click Add Profile.

3. Enter the following information: 

• Profile name: The profile name can be whatever you choose. Since this name appears in 
the System profile drop-down list in the Login dialog box, you might want to choose a 
name that would help you to identify the type of back-end speech recognition system on 
which you will be dictating. 

• Institution: Identifies the back-end speech recognition system. Ask your Dragon 
Medical 360 | Desktop Recorder administrator for the institution name if you do not 
already have it.

• System: Once you have entered a valid institution name, the system name appears in the 
drop-down list.

4. When finished, click OK.
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Delete a System Profile
To delete a system profile:

1. From the login dialog box, click the Manage system profiles link to open the dialog box.

2. Select the profile you want to delete.

3. Click Delete profile.

4. In the Delete System Profile dialog box, click OK to verify that you want to delete the 
profile.
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Overview

You can configure certain settings on your system by clicking the Application Settings icon, 
located on the Login window. Use Application Settings to perform the following tasks:

• Modify your server address and auto-update location, and configure your audio source. (See 
General Tab, beginning on page 14.)

• Customize your user interface. (See Customize UI Tab, beginning on page 18.)

• Configure your foot pedal settings. (See Foot Pedal Configuration Tab, beginning on page 19.)

• Configure barcode settings. (See Barcode Configuration Tab, beginning on page 20.)

• Enable and set up your PACS system to operate with the application. (See Integration Tab, 
beginning on page 22.)
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Accessing the Application Settings Dialog Box
Note: If your computer is running Microsoft Windows 7 or higher, the Application Settings icon 
appears in the login dialog box only if you are logged in to your computer as a Windows 
administrator, or if you start the application by right-clicking the DM360 Recorder icon and 
selecting Run as administrator. Otherwise, the icon is hidden.

1. Double-click the DM360 Recorder icon to open the Login dialog box. 

2. In the lower-right corner of the Login dialog box, click the Application Settings icon.

The Application Settings window opens, with the General tab selected.
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General Tab

The General tab allows you to configure the following settings:

• Login: Enter the address of the server to which you log in to the Dragon Medical 360 | Desktop 
Recorder application.

• Auto update: Enter the address of the server from which automatic updates are received.
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• Audio source configuration: Click this link to open the Windows Sound dialog box on your 
computer, which allows you to configure the source used for recording audio. (An example from 
Windows 7 is shown in the illustration below.)

• Set up microphone: Opens the Microphone Setup Wizard which allows you to select and set 
up your dictation microphone. Follow the steps in the wizard to select and test your microphone.

• Application Diagnostics: When you click the Application Diagnostics link on the General 
tab, the Diagnostics dialog box opens. 

From here you can select a device to test. The test allows you to see how each of the buttons on 
your device is configured. The following examples shows the hand mic and foot pedal 
diagnostics. By pressing and releasing each button, you see a message when each press/release 
is recognized. In addition, the button which you are currently pressing is illuminated in the 
picture (in these examples below, the Record button is pressed). To return to the main 
Diagnostics dialog box, click the blue/white arrow button in the lower-left corner of each 
diagnostics dialog box.

Note: The foot pedal diagnostics dialog box contains a check box which allows you to swap the 
center and right pedals. There are two different types of DAC FP-110 USB foot pedals. This 
setting allows you to easily correct for the foot pedal wiring differences.
15
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Hand Mic Diagnostics Example
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Foot Pedal Diagnostics Example
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Customize UI Tab

The Customize UI tab i allows you to configure the following settings:

• Allow setting priority jobs: Select this check box to allow the user to mark a job as a priority 
job.

• On login, start in full screen mode: Select this check box to start the application in full screen 
mode when you log in. By default, this check box is not selected. 

• Job Identifier: Select either Use voice/text configuration, MRN, Visit ID, or Accession 
number/Order ID to determine the type of identification that will be used to identify the 
patient.

• Require patient identifier with dictation: Select this check box to require that you enter a 
patient identifier before sending a dictation job to transcription. (By default, this check box is 
not selected.)

• Record bar docks top most: Select this check box to dock the application bar to the top of the 
monitor screen without resizing the desktop; the application bar covers the screen's content at the 
top of your monitor. With this check box not selected, the application bar actually “pushes 
down” the monitor's content. Selecting this check box might help to resolve display issues when 
using the application with some PACS systems.
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Foot Pedal Configuration Tab

The Foot Pedal Configuration tab allows you to assign your individual foot pedal buttons in any 
order that you require. 

Refer to Foot Pedal Settings, beginning on page 35, for information on configuring the foot pedal.
19
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Barcode Configuration Tab

The Barcode Configuration tab allows you to configure the following settings:

• Enable barcode input: Select this check box to enable barcode reading and to activate the rest 
of the selections in this dialog box.

• Auto complete current job on barcode read: Select this check box to complete the job on 
which you are currently working when you scan a new barcode. 

• Processing Actions 1 through 5: Use these items to specify what action to take when scanning 
barcodes. When you select an action, you can also specify the number of characters to select. 
The processing actions are described in the following table.

Action Description

Remove leading zeros
Ignores any zeros to the left of the first alphanumeric character (1-9 or A-Z). 
No entry is required in the Number of characters field.

Remove characters from 
beginning

Removes the specified number of characters from the beginning of the 
barcode (0-9; A-Z; special characters $%*-+./). Enter the number of 
characters to remove in the Number of characters field.

Remove characters from 
the end

Removes the specified number of characters from the end of the barcode (0-
9; A-Z; special characters $%*-+./). Enter the number of characters to 
remove in the Number of characters field.

Remove all letters
Removes all alpha characters (A-Z) and leave only numbers (0-9) and special 
characters ($%*-+./). No entry is required in the Number of characters field 
for this action.

Convert all letters to 
number (DTMF)

Converts all letters (A-Z) in the barcode to a corresponding telephone touch-
tone number. For example, a barcode scan result of “123h456” will be 
converted to “1234456.” This feature is great for physicians who are using 
the telephone to review (listen to) dictated reports. No entry is required in the 
Number of characters field for this action. 

Use characters from 
beginning

Uses the first nn characters of the barcode (0-9; A-Z; special characters $%*-
+./). Enter the number of characters in the Number of characters field.

Use characters from the 
end

Uses the last nn characters of the barcode (0-9; A-Z; special characters $%*-
+./). Enter the number of characters in the Number of characters field.

Remove non-numeric 
characters

Removes any non-numeric characters from the barcode. No entry is required 
in the Number of characters field.
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The following illustration shows the Barcode Configuration tab dialog box.
21
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Integration Tab

The Integration tab allows you to configure the following settings:

• Enable PACS integration: Select this check box to enable the PACS integration feature.

• Input file location: Enter the path to the input file.

• Output file location: Enter the path to the output file.

• Context change file location: Enter the path to the context change file.

• Legacy accession field XPath: Allows you to configure which element contains the Accession 
number. A legacy PACS file must still contain the ChunkData root element. This element is used 
to recognize that the legacy PACS integration is to be used. The setting is an XPath expression 
indicating where the accession number is located from the root element. 

• Enable Held status messages: Select this check box to send back a status message when a job is 
put on hold. By default, the check box is not selected. (Applicable only for legacy and desktop 
recorder native integrations.)

• Enable 3rd party Operation Requests: Currently inactive. This check box will be available in 
an upcoming version of the product.
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Overview

You can configure several features in Dragon Medical 360 | Desktop Recorder. Click 
the Dragon logo menu (icon shown at right) on the toolbar to access and manage the 
application’s features.

From the Dragon logo menu you can:

• Change your site

• Determine where the toolbar appears on your screen

• Manage several options relating to your workflow, including audio settings; display; hand mic; 
foot pedal; work type list; and site list

• Determine your user settings location

• Change your password

• Log out of the application

• Exit the application

The rest of this chapter explains how to configure all of these features.
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Dragon Logo Menu

The illustration below shows the menu that opens when you click the Dragon logo, located on 
the left side the toolbar.
25
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Change Site

If you are set up to dictate at more than one site, you choose a specific site from the Site 
Selection list.

To change your site:

1. Click the Dragon logo and select Change site (or press Ctrl+T). The Site Selection dialog 
box opens.

2. Select the site for which you want to dictate.

3. Click OK.

4. The Customize site list link opens the Customize sites dialog box. For information on 
customizing your site list, see Site Settings, beginning on page 38. 
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Toolbar Location

You can choose the location of your toolbar on your computer screen. Each time you log in to 
the application the toolbar appears in this location. 

From the Dragon logo menu, select one of the following:

• Dock to top: Attaches the bar to the top of your screen.

• Dock to bottom: Attaches the bar to the bottom of your screen.

• Floating: Allows you to drag the toolbar anywhere on your screen.

Default is Dock to top.
27
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Options

The Options sub-menu selection has several items you can configure:

• Audio settings

• Display

• Hand mic

• Foot pedal

• Work types

• Sites

To access the Options menu, click the Dragon logo menu and select Options (or press Ctrl+W).
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Audio Settings

1. Click the Dragon logo in the upper-left corner of the toolbar.

2. Click Options (or press Ctrl+W) and then click the Audio settings tab.

3. After setting your options, click OK to save your changes.

Adjust your volume, playback speed and other features by using the audio settings options.

The following list explains each option:

• Volume: Use the slider to adjust your playback volume

• Playback speed: Use the slider to adjust your playback speed; this increases only the speed, 
not the pitch of the playback audio

• Winding speed: Use the slider to adjust your winding speed for rewind and fast forward; 
push slider to right to increase speed, push left to decrease speed.
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• Auto backspace: The amount of time subtracted from the current audio position when you 
play back dictation. Use this setting if your normal workflow is to play back a small portion 
of the current job when resuming dictation, and/or you don’t normally use rewind and fast 
forward much. (This setting can effectively eliminate the need for rewinding.) Set Auto 
backspace from 0 – 10 seconds. The default setting is 0. 

Tones Section

• Theme Selection: Select one of the themes from the drop-down list. The themes each 
have different sounds/tone sets associated with them, which can help to differentiate 
between workstations that are in close proximity to one another. 

• Play beeps when starting and stopping dictation: Select this check box to hear a beep 
when recording begins and ends.

• Play tone when job send to transcription: Select this check box to hear a beep when 
you send a job to transcription.

• Provide feedback during rewind and fast forward: Select this check box to generate 
sounds that help identify where you are in a job while the current position is being 
updated. 

• Play tone when PACS messages are received: Select this check box to hear a beep when 
you receive a message from your PACS.

• Play tone when interactive dialog box is displayed: Select this check box to hear a beep 
when a dialog box that requires your input opens.

• Use Voice Activated Recording with automatic gain control: When you select this check 
box, pressing the Record button on your microphone places the desktop recorder in voice 
activated recording (VAR) mode. When no audio is detected, the recorder will go into a VAR 
pause (see icon below). Then when audio is detected, the recorder will immediately start 
recording.

VAR pause icon: 
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Display Settings
Select your initial view of the application and decide whether to receive confirmation dialogs by 
using the display options.

1. Click the Dragon logo in the upper-left corner of the toolbar.

2. Click Options and then click the Display tab.

3. Select an initial view for this application. This selection defines what you will see each time 
you log in to the application. You can choose to view the application bar (which is the 
default view), the job history window, the held jobs window, and so on.

4. Select a number of days to keep your job history. Maximum number of days is 30.

5. Select the Reset confirmation dialogs check box to begin receiving confirmation requests 
before sending to transcription or your back-end speech recognition system, or when you log 
out of the system.

6. When finished, click OK.
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Hand Mic Settings
To change the function of the buttons on your handheld microphone, click the Dragon logo on 
the toolbar, select Options and click the Hand mic tab.

The illustration below shows the default settings for the Nuance PowerMic II. (Philips 
LFH3500/3600 microphones are supported as well.)

You can return to these settings at any time by clicking the Reset button in the lower-right 
corner of the dialog box. 
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The following table explains the options for assigning buttons on your hand mic (and in general, 
defines each item).

Note: For Press to Rewind/Play and Press to fast forward/Play, the starting playback position 
includes any Auto backspace amount (applied in Audio Settings). We recommend setting Auto 
backspace to zero if you plan to use these functions.

Item Description

Record Press and release the button to begin recording; press and 
release again to pause recording.

Press to record Press and hold the button to record; release the button to pause 
recording.

Send to transcription Press and release the button to send the report to the back-end 
transcription or speech-recognition system.

Play/pause toggle When listening to your recording, press this button to toggle 
between playback and pause.

Press to rewind/Pause Press and hold the button to rewind your recording. When you 
release the button, the recorder goes into the Pause mode.

Press to rewind/Play Press and hold the button to rewind your recording. When you 
release the button, the recorder begins playing back your 
dictation.

Rewind/Jump to beginning Press and release the button to rewind your recording; to stop 
rewinding, press either Play or Record.
To jump to the beginning of your recording, press the assigned 
button twice quickly (within one second).

Pres to fast forward/Pause Press and hold the button to fast-forward your recording. When 
you release the button, the recorder goes into the Pause mode.

Press to fast forward/Play Press and hold the button to fast-forward your recording. When 
you release the button, the recorder begins playing back your 
dictation.

Fast forward/Jump to end Press and release the button to fast forward through your 
recording; to stop fast forwarding, press either Play or Record.
To jump to the end of your recording, press the assigned button 
twice quickly (within one second).

Jump to end Press the button twice quickly (within one second) to move 
immediately to the end of your dictation.

Jump to beginning Press the button twice quickly (within one second) to move 
immediately to the beginning of your dictation.
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Priority Press the button to toggle between priority and not priority. 
Priority marks your report as a priority report and changes the 
icon.

Insert/Overwrite Press the button to toggle between the Insert and Overwrite 
recording modes:

• Insert mode inserts dictation at the current 
location in the recording without overwriting 
existing dictation. 

• Overwrite mode begins recording from the 
current location and overwrites any existing text 
from that time forward until you stop dictating. 

Previous/Up Used for navigational purposes:

• Use to move from left to right across the items in the 
tool bar. For example, if your cursor is in the ID field, 
press this button repeatedly to move to View, 
Commands, Help, the Dragon icon, the Work Type 
selection list, and finally back to the ID field.

• Use to move up through the selections in a menu or 
list. For example, while in the Work type field, use to 
scroll up through the work type selections.

Next/Down Used for navigational purposes:

• Use to move from right to left across the items in the 
tool bar. For example, if your cursor is in the ID field, 
press this button repeatedly to move to the Work Type 
selection list, the Dragon icon, Help, Commands, View, 
and finally back to the ID field.

• Use to move down through the selections in a menu or 
list. For example, while in the Work type field, use to 
scroll down through the work type selections.

Select Use to choose a highlighted selection, such a menu item, or the 
menu itself.

Move to work type field Press and release this button to move to the Work type field.

Move to patient ID field Press and release this button to move to the patient ID field 
(which can display MRN, Visit ID, or Accession number/
Order ID).

Show dictation history Press the button to view the dictation history dialog box.

Item Description

Priority Not Priority
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Foot Pedal Settings
The illustration below shows the default foot pedal settings. (For detailed explanations of each 
foot pedal function, see Using the Foot Pedal, beginning on page 36.)

To change the function of a button, click the direction arrows icons. Use the following table, 
based on the default settings shown in the above illustration, as a guide. (There are several ways 
to move the pedal assignment. The table below shows only a couple of examples.)

Hold the current job Press the button to place the current dictation job on hold (same 
as pressing F6).

Cancel the current job Press the button to cancel the current dictation job (same as 
pressing Ctrl+Shift+X).

Play Press and release the button to play back your dictation.

Pause Press and release the button to pause dictation or playback.

Item Description
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Using the Foot Pedal

Note: USB foot pedals from several manufacturers will work with Dragon Medical 360 | 
Desktop Recorder. You will probably need to experiment with your foot pedal to see which 
buttons trigger the actions listed in the table below.

If you are dictating in a hands-free environment, you can use a USB foot pedal to control 
recording, rewinding, playing back, and sending to transcription.

The following table explains how each button on your foot pedal behaves when you press it.

*A double-tap is pressing and releasing the pedal twice within one second.

Example Task Action

Swap Left with Center
Click the left icon once. Record/Stop moves to the 
left pedal and Send/Send Priority moves to the 
center pedal.

Swap Right with Center
Click the right icon once. Record/Stop moves to the 
right pedal and Rew/Play moves to the center pedal.

Swap Left with Right, 
leaving Center in the center.

• Click the right icon (Record/Stop goes to the 
right pedal, Rew/Play goes to the center pedal).

• Click the left icon (Rew/Play goes to the left 
pedal, Send/Send Priority goes to the center 
pedal).

• Click the right icon again (Send/Send Priority 
goes to the right pedal, Record/Stop returns to the 
center pedal.)

Button Position Action

Record (with Press and 
Release function 
selected)

Press and release (before you 
begin recording)

Start recording

Press and release (when you have 
already started recording)

Toggles between Record and 
Pause

Record (with Press and 
Hold function selected)

Press and hold Starts recording

Release Pauses recording

Rewind/Play

Press and hold Rewind the recording

Release (Up position)
Play back recording from current 
position (based on amount of 
rewind time)

Send/Send Priority

Press and release Sends the job to transcription 

Double-tap*
Marks the job as priority and sends 
the job to transcription or back-end 
speech recognition.
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Work Type Settings
You can choose which of the available work types you want to display in your toolbar's drop-
down list, and set a default work type as well.

To customize which work types appear in this list:

1. Click the Dragon logo in the upper-left corner of the toolbar.

2. Click Options and then click the Work types tab.

3. If you have a large number of work types, enter the first few letters of the work type in the 
Filter field and click the magnifying glass icon to streamline your search.

4. Click the check box next to the work types you want to display, or use the Select all or 
Deselect all buttons. (You can also press and hold the Ctrl key on your keyboard and click 
more than one work type.)

5. Optional: If you want to select a default work type, select a work type and click the Set 
default work type button. A check mark appears to the right of the work type name 
indicating the default work type. In the above illustration, History and Physical has been 
selected as the default work type.

6. When finished, click OK.
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Site Settings
If you dictate for more than one site, you can select one or more sites to display when you log in. 
This allows you to select your site each time you log in. If you select only one site, you will not 
see the site selection menu during login; you will be dictating on the single site you selected.

To customize which work types appear in this list:

1. Click the Dragon logo in the upper-left corner of the toolbar.

2. Click Options and then click the Sites tab.

3. Select one or more sites from which you will choose when you log in to the application. (If 
your site list is extensive, type the first few letters of the site you are looking for in the Filter 
field to streamline your search.) 

Note: If you select only one site, you won't see the site selection dialog box when you 
log in. However, you can still select a different site by clicking the Dragon logo and 
selecting Change site.

4. When finished, click OK.
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User Settings Location

The User settings location option allows you to store your user settings either locally (only on your 
computer) or in the cloud, which makes your user settings available from more than one computer.

1. Click the Dragon logo in the toolbar and select User settings location.

2. Choose one of the two available options:

• Local User Settings: Your user settings are stored on your computer only. No user setting 
information is sent to the Nuance Management Server (NMS). 

• Cloud User Settings: When you log in to Dragon Medical 360 | Desktop Recorder, your 
user settings are downloaded from the NMS and used. When you log out, your user 
settings are saved back to the NMS. 
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Change User Password

Use this dialog box to change your user password for the application.

1. From the Dragon logo menu, click Change password.

2. Enter your old password

3. Enter your new password.

4. Confirm your new password.

5. Click OK.

Log Out

Refer to Log Out, beginning on page 4 for information on logging out of the system.

Exit

Click to close the application completely. Does not return you to the login dialog box.
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Dictating Reports
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Overview

This chapter explains how to use the items on the toolbar when you are working with your dictations 
and reports.

We’ll start from the left side of the toolbar, with the Volume Level indicator, and end with the Jobs 
on Hold icon.

The illustration below (also shown in Chapter 1) will help remind you of the functions of each 
toolbar item. Refer to this illustration when reviewing this chapter.

Quick Start
The following steps briefly explain how to record and send a dictation. 

1. Log in to Dragon Medical 360 | Desktop Recorder.

2. Select a work type (if you dictate on more than one worktype).

3. If required, enter the Visit ID (or MRN or accession number).

4. Press the Dictate button on your microphone and dictate your report.

5. Press the Send to Transcription button on your microphone.
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Volume Level Indicator

This meter shows the audio volume level at which you are dictating.

• To increase your volume level, move the microphone closer to your mouth.

• To decrease your volume level, move the microphone away from your mouth.

The three colors on this indicator show your audio volume level.

• Yellow: Your audio level might be too low, making it difficult for the back-end speech 
recognition system or a transcriptionist to determine what you said.

• Green: Ideal recording level. Try to stay in the green section as much as possible. 

• Red: Try to avoid illuminating the red indicators. If the indicator goes into the red more than 
occasionally, your recording might be distorted, making it difficult for the back-end speech 
recognition system or a transcriptionist to determine what you said.

Dictation Status Indicators

This status indicator displays your current dictation function. The icon changes as you work with 
your dictation.

Use the following table as a guide to these icons.

Icon Description

Pause: Appears by default before you begin dictating. Also appears when you 
pause your dictation or playback.

Record: Appears when you press the Record button on your microphone.

Play: Appears when you are playing back your dictation.

Rewind: Indicates that the recording is rewinding towards the beginning of your 
dictation.

Fast Forward: Indicates that the recording is fast forwarding towards the end of 
your dictation.
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Dictation Length/Location Indicators

This indicator shows you the total length of your dictation as well as your current position within the 
dictation.

The time is shown in minutes and seconds (mm:ss format)

• Current position indicators are the numbers on the left (00:15 in the example below)

• Total length indicators are the numbers on the right (00:36 in the example below)

Priority and Insert/Overwrite Indicators

The following table shows the function and use of the Priority and Insert/Overwrite indicators.

Item Activate/Deactivate Description

Priority
• Assigned mic button, or

• Press F2

Indicates whether the current report is marked as 
priority or not priority. Press the mic button (or F2 
key) to change the status. Notice that the icon 
changes to show you the current status:

Priority

Not Priority

Insert/Overwrite
• Assigned mic button, or

• Press F3

Indicates whether the current report is in the Insert 
or Overwrite recording mode. Press the mic button 
(or F3 key) to change between Insert and Overwrite. 
Notice that the icon changes to show you the current 
status:

Insert mode inserts dictation at the current 
location in the recording without 
overwriting existing dictation.

Overwrite mode begins recording from the 
current location and overwrites any existing 
text from that time forward until you stop 
dictating. 



Chapter 5: Dictating Reports
Work Types

Select a work type from the drop-down list. (The work types that appear will vary from customer to 
customer.)

Note: If you selected only one worktype in your customized worktype list, the single worktype 
appears automatically and you do not have to make a selection.

 

For information on how to customize the list of work types that appears, see Work Type Settings 
beginning on page 37.
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ID Field

Enter the patient's identification information here. You can either type the identifier into the ID field, 
or drag-and-drop the identifier from another application into the ID field. 

Depending upon your settings, this field can display either 

• MRN, 

• Visit ID, or 

• Accession number.

Sending a Job to Transcription without Entering an ID 
Field or Selecting a Worktype

If you selected the Require patient identifier with dictation check box in your settings (see 
Customize UI Tab beginning on page 18), you are required to enter a job identifier. If you are 
required to do so, and forget, a message box opens when you try to send the dictation. Similarly, 
if you did not select a Worktype, you are prompted to do so with a similar dialog box, shown 
below.

Click OK in this dialog box, enter an identifier in the ID field (or select a Worktype from the 
list), and press the Send to transcription button on your microphone again.
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Patient Name Lookup

When you enter a valid patient identifier, the application performs a patient identifier lookup to find 
the patient name. The patient name field is a read-only field.

Before entering a valid visit ID

After entering a valid visit ID

You must enter at least four (4) characters in the patient ID field for the application to perform a 
lookup on the server. Additionally, the application will wait for the patient ID field content to be 
constant for 1.5 seconds before performing the lookup.

Note: Nuance recommends using a 1366 x 768 screen resolution. If the screen resolution does 
not provide enough room for the patient name and/or logout button, the application will hide the 
controls. The logout button will be removed first and if there still isn’t enough room the patient 
name field will be removed. (You can still log out of the application using the Dragon icon and 
selecting Log out.)

Using Full-Screen Mode

If you prefer, you can use Dragon Medical 360 | Desktop Recorder in a full screen view (where the 
application takes up your entire computer screen). The following tips explain how to use this mode.

• To start full screen mode while in the application: Press F11.

• To start full screen mode automatically each time you log in: Select the On login, start in full 
screen mode check box in the Application Settings > Customize UI dialog box.

• To exit full screen mode: Click the Close Window icon in the upper-left corner of the full screen 
window.

• To log out of the application from full screen mode: Click the Log 
out icon in the upper-left corner of the full screen window (or 
press Shift+F4). The Confirm Logout dialog box opens, 
allowing you to log out of the application.
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About Offline Mode
When you use Dragon Medical 360 | Desktop Recorder in the (default) online mode, the 
application stores important information needed for offline use locally on your computer. This 
stored information includes user settings, sites, and work types. The application uses this stored 
information in the event that it has to operate in offline mode.

Note: To work in off-line mode, you must first successfully log in at least one time to the Dragon 
Medical 360 | Desktop Recorder application on your computer while in the online mode. If you 
have not logged in at least once, the information required to allow you to use offline mode will 
not have had a chance to be stored locally and you will not be able to use offline mode.

Note: Dragon Medical 360 | Desktop Recorder has always allowed you to continue dictating if 
you lost connectivity while you were logged in. If connectivity is lost while you are logged in, 
you will be able to continue dictating your current job, and will be able to dictate subsequent 
jobs, as well. If connectivity is restored while you are logged in, the application send any jobs 
completed while offline.

Logging In
If you log in to Dragon Medical 360 | Desktop Recorder, and the system detects that you are not 
connected to the application server, you will see a message box explaining that you are starting 
in the offline mode. You can click the Start button to log in or wait five seconds to be logged in 
automatically.

Am I in Online or Offline Mode? Look for the Icon! 
To tell what mode you are in, look for the Offline mode indicator in the tool bar, just to the right 
of your user name. If the indicator is there, you are in Offline mode. If the indicator does not 
appear, you are in Online mode.

The application contains a background task that periodically checks to see whether a connection 
to the back-end system has been restored. When the connection is restored, the application 
automatically switches from offline to online mode. If you have started a new dictation and the 
current job contains audio, the application waits until you finish the job before switching to 
online mode.
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Features Not Supported While in Offline Mode
In offline mode, the application does not allow you to use the following features:

• Patient Name Lookup

• Options menu item

• User settings location 

• Change your password 

Uploading Jobs
In offline mode, the application does not attempt to upload jobs to the back-end system. When 
the application is back on line, you do not need to do anything to upload the jobs you created 
offline; the jobs you completed in offline mode are automatically uploaded. 
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PACS Integration

When dictating using Desktop Recorder with an integration to a PACS, you initiate a dictation from 
your PACS worklist. This will populate the Desktop Recorder with the accession number for the 
selected image so that you do not have to type or barcode it. When you send the dictation for 
transcription, the status of the image in the PACS worklist will be updated.

Context Change
A context change occurs if you select an image from the PACS worklist, but currently have a 
dictation open in the Desktop Recorder for a different accession number. When a context change 
is detected, the following dialog box opens.

The following options are available:

• Ignore new data: Retains the current accession number – 555555.

• Replace old data: Replaces accession number 555555 with accession number111111 for the 
current dictation that is still in Desktop Recorder. In this case, the audio has not yet been 
sent.

• Cancel current job: Deletes any audio that has been recorded and starts a new dictation 
with the new accession number – 111111.
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McKesson Integration Close Study Handling
The following dialog will display if you close a job in McKesson before sending the audio to 
transcription:

The following options are available:

• Send job to transcription: Sends the current job for transcription.

• Hold: Places the current job on hold.

• Cancel: Cancels the current job and deletes the audio.
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Additional Toolbar Items
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Overview

In addition to the icons and tools on the toolbar, the far right side of the toolbar contains three menu 
items: View, Commands, and Help.

View Menu

The View menu allows you to see additional information about your dictation jobs, and to 
control whether to use full screen viewing mode. You can click an item or use the keyboard 
sequence shown to open these windows.

• Patient list: For more information about inpatient patient list, please contact your Nuance 
Sales Representative or Client Development Executive (CDE).

• Held jobs view: Shows you a list of jobs that you put on hold and allows you to resume or 
cancel the jobs. (See Held Jobs View, beginning on page 55.)

Note: The Jobs on Hold indicator appears to the right of the Help item if you 
have jobs on hold.

• History view: Opens the Job History dialog box, allowing you to resume a job or retry 
uploading jobs that did not upload. (See History View, beginning on page 56.)

• Integration details: Shows information about your PACS integration. (See Integration 
Details, beginning on page 57.)

• Full screen: Displays the record/playback portion of the tool bar in full screen mode. This 
mode is useful if you are dictating hands-free and/or using a foot pedal to control your 
recording.
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Held Jobs View
When you click View > Held jobs view (or press Shift+F6), the Held Jobs dialog box opens. 
From here you can:

• Resume work on an existing job (select a job and click Resume Job), 

• Cancel a job (select one or more jobs and click Cancel Job), or 

• Close the window (click Close Window or press the Esc key).

Note: You can use the Windows Shift + Click or Ctrl + Click commands to select consecutive or 
non-consecutive jobs, respectively.

Cancelling a Held Job

If you decide to cancel a held job, the following dialog box opens:

Note: Cancelling a held job deletes the job’s audio file.
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History View
When you click View > History view (or press Ctrl+H), the Job History dialog box opens. The 
job information is available for 30 days from the time the job is uploaded. (For jobs older than 
30 days, view job history by using the Job Lister feature in the Nuance Enterprise Voice system.)

From the Job History window you can:

• Retry uploading a job (select one or more jobs and click Retry Upload), or 

• Resume work on an existing job (select a job and click Resume Job), 

• Close the window (click Close Window or press the Esc key).

A job row highlighted in yellow indicates a job marked as a Priority job.

Note: You can use the Windows Shift + Click or Ctrl + Click commands to select consecutive or 
non-consecutive jobs, respectively.
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Integration Details
When you click View > Integration details (or press Ctrl+Shift+I), the Integration Details 
dialog box opens. From here you can:

• View information about your last transfer,

• View events related to your PACS integration (assuming the integration is enabled), or 

• Close the window.
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Commands Menu

The toolbar's Commands menu displays the commands you can use to work with and manage your 
dictation jobs. 

You can click a command with your mouse, or enter the command's keystroke to execute the action. 

In addition, you can assign most of these commands to a button on your microphone.

Item Description

Send to transcription Click to send the report to the back-end transcription or speech-
recognition system.

Cancel current job Click to cancel the current dictation job.

Hold current job Click to place the current dictation job on hold.

Record Click to begin dictating.

Pause Click to pause your dictation or playback.

Play Click to begin playing back your dictation.

Fast forward Click to begin fast-forwarding through your dictation.

Rewind Click to begin rewinding your dictation.
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Help Menu

The toolbar's Help menu allows you to access this online help file. 

• Click Help or press F1 to see the online help for the product.

• Click About DM360 | Desktop Recorder to see the current version of the Dragon Medical 360 
| Desktop Recorder software installed on your computer.

Jump to beginning Click to move immediately to the beginning of your dictation.

Jump to end Click to move immediately to the end of your dictation.

Move to work type Click to move your cursor to the Work type field.

Move to patient ID Click to move your cursor to the patient ID field (which can 
display MRN, Visit ID, or Accession number/Order ID).

Priority Click to toggle between priority and not priority. Priority marks 
your report as a priority report and changes the icon.

Insert/Overwrite Click to toggle between the Insert and Overwrite recording 
modes:

• Insert mode inserts dictation at the current 
location in the recording without overwriting 
existing dictation. 

• Overwrite mode begins recording from the 
current location and overwrites any existing text 
from that time forward until you stop dictating. 

Item Description

Priority Not Priority
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